About This Document

This manual is intended for administrators and users of the AXIS 213 PTZ Network Camera, and is applicable for software release 4.30. Previous experience of networking will be of use when installing and using this product. Some knowledge of UNIX or Linux-based systems would also be beneficial, for developing shell scripts and applications. Later versions of this document will be posted to the Axis Website, as required.

Safety Notices Used In This Manual

Caution! - Indicates a potential hazard that can damage the product.

Important! - Indicates a hazard that can seriously impair operation.

Do not proceed beyond any of the above notices until you have fully understood the implications.

Intellectual Property Rights

Axis AB has intellectual property rights relating to technology embodied in the product described in this document. In particular, and without limitation, these intellectual property rights may include one or more of the patents listed at http://www.axis.com/patent.htm and one or more additional patents or pending patent applications in the US and other countries.

This product contains licensed third-party software. See the menu item “About” in the product’s user interface for more information.

This product contains source code copyright Apple Computer, Inc., under the terms of Apple Public Source License 2.0 (see http://www.opensource.apple.com/apsl/). The source code is available from: http://developer.apple.com/darwin/projects/bonjour/

Legal Considerations

Camera surveillance can be prohibited by laws that vary from country to country. Check the laws in your local region before using this product for surveillance purposes.

Electromagnetic Compatibility (EMC)

USA - This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance with the instruction manual, may cause interference to radio communications. It has been tested and found to comply with the limits for a Class B computing device pursuant to Subpart B of Part 15 of FCC rules, which are designed to provide reasonable protection against such interference when operated in a commercial environment. Operation of this equipment in a residential area is likely to cause interference, in which case the user at his/her own expense will be required to take whatever measures may be required to correct the interference. Shielded cables should be used with this unit to ensure compliance with the Class B limits.

Canada - This Class B digital apparatus complies with Canadian ICES-003.

Europe - This digital equipment fulfills the requirements for radiated emission according to limit B of EN55022:1998, and the requirements for immunity according to EN55024:1998 residential, commercial, and light industry.

Japan - This is a class B product based on the standard of the Voluntary Control Council for Interference from Information Technology Equipment (VCCI). If this is used near a radio or television receiver in a domestic environment, it may cause radio interference. Install and use the equipment according to the instruction manual.

Australia - This electronic device meets the requirements of the Radio communications (Electromagnetic Compatibility) Standard 1998 AS/NZS 3548.

Liability

Every care has been taken in the preparation of this manual; please inform your local Axis office of any inaccuracies or omissions. Axis Communications AB cannot be held responsible for any technical or typographical errors and reserves the right to make changes to the product and manuals without prior notice. Axis Communications AB makes no warranty of any kind with regard to the material contained within this document, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Axis Communications AB shall not be liable nor responsible for incidental or consequential damages in connection with the furnishing, performance or use of this material.

Trademark Acknowledgments

Ethernet, Internet Explorer, Linux, Macintosh, Microsoft, Mozilla, Netscape Navigator, UNIX, Windows, WWW are registered trademarks of the respective holders. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries. UPnP is a certification mark of the UPnP Implementers Corporation. Axis Communications AB is independent of Sun Microsystems Inc.

Axis Customer Services

Should you require any technical assistance, please contact your Axis reseller. If your questions cannot be answered immediately, your reseller will forward your queries through the appropriate channels to ensure a rapid response. If you are connected to the Internet, you can:

• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database
• report problems to Axis support staff by logging in to your private support area
• visit the Axis Support Web at www.axis.com/techsup/

Safety Notice - Battery Replacement

The AXIS 213 uses a 3.0V CR2032 Lithium battery as the power supply for its internal real-time clock (RTC). This battery will, under normal conditions, last for a minimum of 5 years. Low battery power affects the operation of the RTC, causing it to reset at every power-up. A log message will appear when battery replacement is required. The battery should not be replaced unless required! If the battery does need replacing, please observe the following points:

• Caution! Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer’s instructions.
# Table of contents

Product Description .................................................................................................................. 5  
Hardware Inventory ................................................................................................................... 5  
AXIS 213 PTZ Network Camera ............................................................................................... 6  
Accessing the camera .............................................................................................................. 8  
Accessing from a browser ....................................................................................................... 8  
Setting the Password ............................................................................................................. 9  
Accessing the camera from the Internet ................................................................................... 9  
The Live View page .................................................................................................................. 10  
Video and Audio Streams ....................................................................................................... 13  
Video Stream Types ............................................................................................................... 13  
MPEG-4 protocols and communication methods .................................................................... 14  
How to stream MPEG-4 ......................................................................................................... 14  
AXIS Media Control ............................................................................................................... 15  
Other methods of accessing the video stream ....................................................................... 16  
Setup ..................................................................................................................................... 18  
Accessing the setup tools from a browser ............................................................................. 18  
Event Configuration ................................................................................................................ 34  
Event Servers ........................................................................................................................ 34  
Event Types ........................................................................................................................... 35  
Motion Detection .................................................................................................................... 37  
To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is recommended. 38  
Port Status ................................................................................................................................ 38  
System Options ......................................................................................................................... 39  
Security .................................................................................................................................. 39  
Date & Time ............................................................................................................................. 40  
Network ................................................................................................................................ 40  
Network - SOCKS .................................................................................................................. 43  
Network - SMTP (email) ......................................................................................................... 43
Product Description

The AXIS 213 is a full-featured PTZ Network Camera for security surveillance and remote monitoring. The images from the camera are made available on the network as real-time, full frame rate Motion JPEG streams and/or MPEG-4 video streams. The AXIS 213 also has an infrared (IR) lamp and a removable IR filter for day and night operation.

The AXIS 213 can optionally be equipped with a connection module with 2 inputs and 3 outputs, which can be connected to external devices, e.g. door sensors. The connection module has an audio in and an audio out port, to support two-way audio.

Video can be viewed in 5 resolutions (up to 768x576). Up to 20 viewers can access the AXIS 213 simultaneously when using Motion JPEG and MPEG-4 unicast. The number of simultaneous viewers can be increased by using multicast MPEG-4.

The AXIS 213 contains advanced scheduling tools that can be used to trigger an event. As the AXIS 213 is designed for use in security systems, it is equipped with security features such as IP address filtering and multilevel passwords. The AXIS 213 has a built-in Web server, providing full access to all features through the use of a standard Web browser.

Hardware Inventory

Check the items supplied with your AXIS 213 against the following list:

<table>
<thead>
<tr>
<th>Item</th>
<th>Title/Variants</th>
</tr>
</thead>
<tbody>
<tr>
<td>PTZ Network Camera</td>
<td>AXIS 213</td>
</tr>
<tr>
<td>Indoor power adapter with power cable</td>
<td>Europe</td>
</tr>
<tr>
<td></td>
<td>UK</td>
</tr>
<tr>
<td></td>
<td>Australia</td>
</tr>
<tr>
<td></td>
<td>USA/Japan</td>
</tr>
<tr>
<td></td>
<td>Korea</td>
</tr>
<tr>
<td>Printed documentation</td>
<td>AXIS 213 Installation Guide</td>
</tr>
<tr>
<td>Warranty document</td>
<td></td>
</tr>
<tr>
<td>CD</td>
<td>Contains complimentary software and documentation.</td>
</tr>
</tbody>
</table>

Optional Accessories | Connection Module (Audio)
AXIS 213 PTZ Network Camera

1. **IR Light** - infrared light for night vision. Activated from the AXIS 213 web page.

2. **Network Indicator** - the multi-colored network indicator flashes as follows:
   - **Amber** - flashes for activity on a 10 Mbit/s network
   - **Green** - flashes for activity on a 100 Mbit/s network
   - **Red** - flashes red for hardware error
   - **None** - no connection or disabled by the administrator

3. **Network Connector** - The AXIS 213 connects to the network via a standard RJ-45 connector. The AXIS 213 detects the speed of the local network segment (10BaseT/100BaseTX Ethernet).

4. **Output/Input Connector** - For connection of the connection module cable. See below for information.

5. **Power Connector** - For connection of the power adapter (included).

The Reset Button is located on the underside of the unit. This button is used to restore the factory default settings, as described in Resetting to Factory Default Settings, on page 47 or to install the AXIS 213, see the Installation Guide for more information.

The Serial Number is located on the label on the underside of the unit.
**Optional Accessory:**

**Connection Module** - The connection module provides the physical interface to 3 relay outputs, 2 digital inputs, audio in/out, video in/out and the RS-232C serial port. See Connection Module, on page 48 for more information.

![Connection Module](image)

**Note:** For information on installing the AXIS 213, please refer to the Installation Guide.
Accessing the camera

The AXIS 213 can be used with most standard operating systems and supports Microsoft Internet Explorer 5.x or later, Netscape 7.x or later and Mozilla 1.4 or later.

**Note:** To view streaming video in Microsoft Internet Explorer, you must set your browser to allow the AXIS Media Control (AMC) to be installed on your computer. The first time an MPEG-4 video stream is accessed, AMC also installs an MPEG-4 decoder for viewing the video stream. As a license is required for each instance of the decoder, the product administrator may have disabled the installation. If your workstation restricts the use of additional software components, the camera can be configured to use a Java applet for updating JPEG images. See the online help for more information.

**Accessing from a browser**

1. Start a browser (Internet Explorer, Mozilla, Netscape Navigator).
2. Enter the IP address or host name of the AXIS 213 in the **Location/ Address** field of your browser.
3. Enter the user name and password set by the administrator.
4. A video image is displayed in your browser.

**Notes:**

- User functions in the AXIS 213 may have been customized to meet the specific requirements of the application. Consequently, many of the examples and functions in this section may differ from those displayed in your Live View page.
- If the AXIS 213 is to be placed upright on a desktop, the image must be rotated. Go to **Setup > Video & Image** and set Rotate image to 180 degrees.
Setting the Password

1. When accessing the camera for the first time, the ‘Configure Root Password’ dialog will be displayed on the screen.

2. Enter a password and then re-enter it, to confirm the spelling. Click OK.

3. The ‘Enter Network Password’ dialog will appear. Enter the User name: root
   Note: The default administrator user name root is permanent and cannot be deleted or altered.

4. Enter the password as set in step 2 above, and click OK. If the password is lost, the camera must be reset to the factory default settings. See __.

5. If required, click Yes to install the AXIS Media Control (AMC). You will need administrator rights on the computer to do this.

Accessing the camera from the Internet

Once installed, the camera is accessible on your local network (LAN). To access the camera from the Internet you must configure your router/firewall to allow incoming data traffic. For security reasons this is usually done on a specific port. Please refer to the documentation for your router/firewall for further instructions.

For more information, please visit the AXIS Internet Dynamic DNS Service at www.axiscam.net or, for Technical notes on this and other topics, visit the Axis Support Web at www.axis.com/techsup
The Live View page

The following provides an overview of each button on the Live View page. If the AXIS 213 has been customized, the buttons will be displayed accordingly:

To resize the displayed image, click the View Size buttons: half-size (x\(\frac{1}{2}\)), full-size (x1), x2 or x4. This will not change the resolution of the image (not available in Sequence Mode).

The Video Format drop-down list allows the video format on the Live View page to be temporarily changed.

The 2 types of Output button each control the output directly from the Live View page. These are configured under Setup > Live View Config > Layout.

- **Pulse** - click this button to activate the output for a defined period of time, e.g. to switch on a light for 20 seconds.
- **Active/Inactive** - click these buttons to manually start and stop a connected device, e.g. switch a light on/off.

These buttons start/stop the Sequence Mode which automatically displays the view from preset positions at set intervals. Sequence mode is configured in Setup > PTZ Configuration > Sequence Mode.

The source list is used to select the preset positions already configured in the camera. These are created in Setup > PTZ Configuration > Preset Positions.

The Manual trigger buttons trigger an action directly from the Live View page. These buttons are configured under Setup > Live View Config > Layout. Click these buttons to manually start and stop events.

Use the Snapshot button to capture a snapshot of the image currently being displayed in the window. Right-click on the image to save it in JPEG format on your computer.
The **AMC viewer toolbar** is available in **Microsoft Internet Explorer only**. See **AXIS Media Control (AMC)**, on page 9 for more information. The AMC viewer toolbar displays the following buttons:

- **The Play/Stop** buttons start and stop the live video stream.

- **The Snapshot** button takes a snapshot of the currently displayed image. The Snapshot function and the target directory for saving snapshots can be configured from AMC (AXIS Media Control), which is available from the Windows Control Panel (Internet Explorer only).

- Click the **View Full Screen** button and the video image will fill the entire screen area. No other windows will be visible. Press **Esc** (Escape) on the computer keyboard to cancel full screen view.

- Click the **Mute /Microphone** buttons to switch the sound off and on. Only available if **Audio** is enabled and the **Connection Module** with a loudspeaker/microphone is connected.

- Use the sliders to control the volume on the speaker and microphone. The volume can be set between 0 and 100.

The Live View page also displays the **Pan/Tilt/Zoom controls**. The controls can be disabled/enabled for specified users by the administrator under **System Options > Security > Users > User List**.

- **Home** If configured, clicking this box will move the AXIS 213 to a preset position called "Home". See **Preset Positions**, on page 32 for more information.

The manual Pan Tilt and Zoom bars control their respective functions in two different ways. Clicking anywhere on the bar's gradient allows for a 'smooth' adjustment of the camera's position, whilst clicking on the arrows at the two ends of the bar cause a stepped, incremental change.

**Note:** Setting the iris and focus manually will disable **Auto iris/Auto focus**.
Control Panel
Click the Ctrl panel button to display the control panel where the following settings are available:

- **Auto focus** - the AXIS 213 can be set to automatically adjust the image focus.
- **Auto iris** - the iris can automatically adjust the amount of light reaching the camera and give the best results, as well as protecting the image sensor from strong light.
- **Backlight compensation** makes the subject appear clearer against e.g. a bright background.
- **Navigation mode:**
  - Select **Center** and the camera view will center on the position that was clicked.
  - Select **Joystick** and the camera will move in the direction indicated by a mouse click, relative to the center of the image. The further from the center the image is clicked, the greater the movement.
- **IR light** - use the IR light on the front of the camera to enable night vision.
- **IR cut filter** - when set to off, the camera will be able to 'see' the infrared light, e.g. at night, thus making the image clearer. The image is shown in black & white when the IR cut filter is off.

Pan/Tilt/Zoom Control Queue
Only one user can use the Pan/Tilt/Zoom controls at any time. So when multiple clients access the AXIS 213’s Live View page, it is necessary to queue the users and restrict the length of time they are in control of the Pan/Tilt/Zoom controls. Use the buttons to request or release control of the Pan/Tilt/Zoom controls.

The Pan/Tilt/Zoom Control Queue is set up by the administrator under **PTZ Configuration > Control Queue**.
Video and Audio Streams

The AXIS 213 provides several different image and video formats. The type to use depends on your requirements and on the properties of your network.

The Live View page in the AXIS 213 provides access to Motion JPEG and MPEG-4 video streams, as well as to single JPEG images. Other applications and clients can also access these video and audio streams/images directly, without going via the Live View page.

Video Stream Types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then displayed and updated at a rate sufficient to create a stream that shows constantly updated motion.

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides excellent image quality and access to each and every individual image contained in the stream.

Note also that multiple clients accessing Motion JPEG streams can use different image settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can provide high-quality video streams at less than 1 Mbit/s.

The MPEG-4 standard provides scope for a large range of different coding tools for use by various applications in different situations, and the AXIS 213 provides certain subsets of these tools. These are represented as Video object types, which are selected for use with different viewing clients. The supported video object types are:

- **Simple** - sets the coding type to H.263, as used by e.g. QuickTime™.
- **Advanced Simple** - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS Media Control)

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the amount of bandwidth usage to be controlled. CBR (constant bit rate) is used to achieve a specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (variable bit rate), the quality of the video stream is kept as constant as possible, at the cost of a varying bit rate.
Notes:  
• MPEG-4 is licensed technology. The AXIS 213 includes one viewing client license. Installing additional unlicensed copies of the viewing client is prohibited. To purchase additional licenses, contact your Axis reseller.  
• All clients viewing the MPEG-4 stream must use the same image settings.

**MPEG-4 protocols and communication methods**

To deliver live streaming video over IP networks, various combinations of transport protocols and broadcast methods are employed.

• **RTP (Realtime Transport Protocol)** is a protocol that allows programs to manage the real-time transmission of multimedia data, via unicast or multicast.

• **RTSP (Real Time Streaming Protocol)** serves as a control protocol, to negotiate which transport protocol to use for the stream. RTSP is thus used by a viewing client to start a unicast session, see below.

• **UDP (User Datagram Protocol)** is a communications protocol that offers limited service for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not required to deliver all data and may drop network packets when there is e.g. network congestion. This is suitable for live video, as there is no point in re-transmitting old information that will not be displayed anyway.

• **Unicasting** is communication between a single sender and a single receiver over a network. This means that the video stream goes independently to each user, and each user gets their own stream. A benefit of unicasting is that if one stream fails, it only affects one user.

• **Multicast** is bandwidth-conserving technology that reduces bandwidth usage by simultaneously delivering a single stream of information to multiple network users. This technology is used primarily on delimited networks (intranets), as each user needs an uninterrupted data flow and should not rely on network routers.

**How to stream MPEG-4**

Deciding on the combination of protocols and methods to use depends on your viewing requirements, and on the properties of your network. Setting the preferred method(s) is done in the control applet for AMC, which is found in the Windows Control Panel. When this has been set, AMC will test all the selected methods in the specified order, until the first functioning one is found.
**RTP+RTSP**
This method (actually RTP over UDP and RTSP over TCP) should be your first consideration for live video, especially when it is important to always have an up-to-date video stream, even if some images do get dropped. This can be configured as multicast or unicast.

Multicasting provides the most efficient usage of bandwidth, especially when there are large numbers of clients viewing simultaneously. Note however, that a multicast broadcast cannot pass a network router unless the router is configured to allow this. It is thus not possible to multicast over e.g. the Internet.

Unicasting should be used for video-on-demand broadcasting, so that there is no video traffic on the network until a client connects and requests the stream. However, as more and more unicast clients connect, the traffic on the network will increase and may cause congestion. Although there is a maximum of 20 unicast viewers, note that all multicast users combined count as 1 unicast viewer.

**RTP/RTSP**
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it is relatively simple to configure firewalls to allow RTSP traffic.

**RTP/RTSP/HTTP or RTP/RTSP/HTTPS**
These two methods can also be used to traverse firewalls. Firewalls are commonly configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

**AXIS Media Control**
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) and audio from the AXIS 213 is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer in Windows. This ActiveX component is automatically installed on first use, after which it can be configured by opening the AMC Control Panel applet from the Windows Control Panel. Alternatively, right-click the video image in Internet Explorer.
Other methods of accessing the video stream

Video/images from the AXIS 213 can also be accessed in the following ways:

- If supported by the client, the AXIS 213 can use Motion JPEG server push to display video. This option maintains an open HTTP connection to the browser and sends data as and when required, for as long as required.
- As single JPEG images in a browser. Enter e.g. the path: http://<ip>/axis-cgi/jpg/image.cgi?resolution=CIF
- Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The paths that can be used are listed below, in the order of preference.
  - Unicast via RTP: axrtpu://<ip>/mpeg4/media.amp
  - Unicast via RTSP: axrtsp://<ip>/mpeg4/media.amp
  - Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip>/mpeg4/media.amp
  - Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip>/mpeg4/media.amp
  - Multicast: axrtpm://<ip>/mpeg4/media.amp

Note: <ip> = IP address.

Other MPEG-4 clients

Although it may be possible to use other clients to view the MPEG-4 stream, this is not guaranteed by Axis.

For some other clients, e.g. QuickTime™ the Video Object Type must be set to Simple. It may also be necessary to adjust the advanced MPEG-4 settings.

To assess the video stream from e.g. QuickTime™ the following path can be used:
rtsp://<ip>/mpeg4/media.amp

This path is for all supported methods, and the client will negotiate with the AXIS 213 to determine exactly which transport protocol to use.

Note: <ip> = IP address.

Audio transmission methods

The audio stream can be accessed in the Live View page when viewing either Motion JPEG or MPEG.
Using Motion JPEG
The basic transmission method of audio used in conjunction with Motion JPEG video streaming is transmission over HTTP. The video and audio streams are not synchronized when using Motion JPEG so the streams may be slightly out of sync. The latency in any stream should be low, but this will depend on the network infrastructure.

Using MPEG-4
When using MPEG-4, audio is streamed using the same protocol as the video stream.

When audio is transmitted using MPEG-4, the Axis product sends synchronization information along with the streams to the client that is performing the synchronization.

Audio is streamed from the client to the server over HTTP when using Motion JPEG and MPEG-4.

Accessing the Audio Streams
In addition to accessing audio in the Live View page using AMC, audio from the Video Server can also be accessed in the following ways:

HTTP-API
You can read about accessing audio for the other protocols through the HTTP-API at http://www.axis.com/techsup

QuickTime/Windows Media Player
It is possible to use QuickTime and Windows Media Player to listen to the audio stream using the same methods to access video streams.
Setup

The AXIS 213 is configured from the setup tools, which are available from the link in the web interface. The setup tools can be used by:

- **administrators**, who have unrestricted access to all the Setup tools
- **operators**, who have access to the Video & Image, Live View Config and Event Configuration settings.

See the section on Security, on page 39 for more information on user access control.

Accessing the setup tools from a browser

Follow the instructions below:

1. Start the browser and enter the IP address or host name of the AXIS 213 in the location/address field.

2. The **Live View** page is now displayed. Click **Setup** to display the **Setup** configuration tools.
Video & Image settings
The following descriptions offer examples of the available features in the AXIS 213. For details of each setting, please refer to the online help files which are available from each page. Click to access the help files.

To optimize the video images to your requirements, modify the following settings under **Image Appearance**:

- Resolution (including Aspect ratio correction and 4CIF de-interlacing)
- Compression
- Rotate Image
- Color Setting
- Brightness

**Note:** All configuration of images and overlays will affect the performance of the AXIS 213, depending on the usage and the available bandwidth. Please keep in mind the following when changing the image settings:

- Lower compression improves image quality, but generates larger files
- Color uses more bandwidth than Black & White
- Rotating the image 90 or 270 degrees will lower the maximum frame rate
- When using MPEG-4 as the video format, the compression setting will define the minimum compression level. The compression level will temporarily increase as and when required, i.e. when the bit rate approaches the maximum value as defined in the current profile@level combination.

You may need to press the **Stop** and **Play** buttons on the Live View page before the settings take effect.

**Overlay Settings**

Include an image and date and time with your own text which is placed on one line at the top or bottom of the video image.

See Overlay Image Settings, on page 20 for instructions on how to upload an overlay image to the AXIS 213.
Video Stream

Define the maximum video stream time per session in seconds, minutes or hours. When the set time has expired, a new stream can be started by refreshing the page in the browser.

Define the maximum frame rate (fps - frames per second) allowed for each viewer, to avoid bandwidth problems on the network.

Test - For a preview of the image and overlay settings before saving, click Test. The Brightness setting does not affect the Test image. When satisfied with the settings, click Save. Please note that the preview image will be in JPEG format, even though the settings are valid both for Motion JPEG and MPEG-4.

Overlay Image Settings

An overlay image is an image included in the video image. This might, for example, be your own company logo. Follow these instructions to upload and use an overlay image:

1. Go to Setup > Video & Image > Overlay Image.
2. To upload the image to the AXIS 213, click the Browse button and locate it on your computer or server.
3. Click the Upload button and follow the on-screen instructions.
4. The image is now available in the Use overlay image drop-down list.
5. Click Save.
6. Go to Setup > Video & Image and modify the parameters under Overlay Settings.

Overlay image requirements:

<table>
<thead>
<tr>
<th>Image Formats</th>
<th>Image Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 24-bit BMP (full color)</td>
<td>The height and width of the overlay image in pixels must be exactly divisible by 4.</td>
</tr>
<tr>
<td>Windows 4-bit BMP (16 colors)</td>
<td></td>
</tr>
</tbody>
</table>

There are a number of limitations when using overlay images, such as the size and positioning of images. Please use the online help 🛠 for more information.
Advanced settings

Camera - To optimize the lighting settings according to your requirements, modify the following settings under **Lighting Conditions**:

- **White balance** - the white balancing system in the AXIS 213 can automatically detect white in the image and intelligently use this as a reference for other colors.
- **Exposure control** - this setting is used to adapt to the amount/type of light being used. If set to **Manual**, select the desired **Shutter speed** from the drop-down list.
- **IR cut filter** - turn the IR filter on or off. To light up the IR lamp on the front of the AXIS 213, turn the IR cut filter **Off** and click **Save**. The **Set IR Lamp** buttons will appear. The lamp will automatically switch off after 8 hours.
- **Backlight compensation** - this setting is used to make the subject appear clearer against e.g. a bright background.

**Notes:**
- If configured by the administrator under **Live View Config > Layout > IR Buttons** the viewer is able to switch the IR lamp and IR filter on and off, directly from the Live View page.
- In certain situations, the white balancing system will not operate effectively. Problems may occur if the image contains no white color at all, or if the dominant color is not white. In these circumstances, the white balance may incorrectly be based on another visible color in the image, and colors may become distorted. A pale background picture with reddish or blue foreground objects is very symptomatic of this condition. In such cases it is recommended that a fixed white balance setting is selected.

Image Settings

- **Auto focus enabled** (default setting)
- **Noise reduction** - sets the level of noise reduction in the image. i.e. sharpens the image. Setting the noise reduction to ‘high’ will cause a drop in frame rate (fps). Please see the online help 🔄 for more information.
MPEG-4 Settings

The AXIS 213 supports the following different MPEG-4 profiles and levels:

<table>
<thead>
<tr>
<th>Profile@ Level</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Simple Profile @ Level 3</td>
<td>Max bit rate = 768 kbit/s</td>
</tr>
<tr>
<td></td>
<td>ISMA compliant</td>
</tr>
<tr>
<td>Advanced Simple Profile @ Level 5</td>
<td>Max Bit rate = 8 Mbit/s</td>
</tr>
</tbody>
</table>

Level 5 is preferred if there is enough bandwidth available, as the image quality of the video stream will be better than if level 3 is used. The viewing client must support the profile used for the video stream otherwise the MPEG-4 stream can not be viewed.

**Note:** The Axis Media Control supports all the configuration possibilities available on this page.

The **GOV structure** can be set to either I or IP, which describes the type of images included in the video stream, as well as their internal order. The IP-structure generally sends the differences compared to the previous image and far fewer complete images, so this method uses much less bandwidth than the I-structure. The I-structure gives higher frame rates when using a high resolution, but requires more bandwidth.

The **GOV length** determines the sum total of P-images and I-images in a GOV. Setting the GOV length to a high value saves considerably on bandwidth. However there may be noticeable decay in the image at high values.

**Note:** GOV = Group of VOPs  
VOP = Video Object Plane  
Video Object Plane = image
Bit Rate Control

Limiting the maximum bit rate is a good way of controlling the bandwidth used by the MPEG-4 video stream. Leaving the Maximum bit rate as unlimited will provide consistently good image quality, but at the expense of increased bandwidth usage whenever there is more activity in the image. Limiting the bit rate to a defined value will prevent excessive bandwidth usage, but images will be lost when the limit is exceeded.

Note that a maximum bit rate can be used for both variable and constant bit rates. The bit rate type can be set as Variable Bit Rate (VBR) or Constant Bit Rate (CBR). VBR will adjust the bit rate according to the images' complexity, thus using a lot of bandwidth for a lot of activity in the image and less for lower activity in the monitored area.
Audio Settings

This section describes how to configure the basic audio settings for the AXIS 213, e.g. set the communication mode and adjust the sound levels in the microphone and speaker connected to the connection module.

General

Enable audio transmission to and from the AXIS 213 using the connection module which is an optional accessory. Refer to Installing the audio equipment, on page 48 for more information.

Audio Channels

There are two mono audio channels between the AXIS 213 and other clients, one for receiving audio and one for transmitting audio. Each audio channel can be turned on or off, which means that there are four audio mode options that can be used.

Full-duplex mode means that you can transmit and receive audio (talk and listen) at the same time, without having to use any of the controls. This is just like having a telephone conversation. The only controls you may wish to use are the mute buttons to turn off the sound, and the sliders, to adjust the input/output volume levels. This mode requires that the client PC has a sound card with support for full-duplex audio. If your available bandwidth is 0.2 Mbit/s or less, it is recommended that you use Half-duplex mode instead.
**Half-duplex** mode also transmits and receives audio in both directions, but only in one direction at a time. This means that you must select when to receive or transmit audio with the help of the push-to-talk button. To speak, press and hold the button (check that the microphone is not muted). When finished speaking, release the button. You will now be receiving audio from the other end of the connection.

Note that the push-to-talk button is configured from AMC, see AXIS Media Control (AMC), on page 9. It is also possible to configure the Push-to-talk button so that it toggles between speaking and listening modes. Half-Duplex mode is best if you only have limited bandwidth available.

When you select **Simplex - AXIS 213 speaker only** mode, the speaker connected to the AXIS 213’s connection module will play audio, but no audio will be transmitted from the AXIS 213 to other web clients. This could be used to e.g. provide spoken instructions to a person seen in the network camera. This mode requires you to use the push to talk button.

**Simplex - AXIS 213 microphone only** mode transmits audio from the microphone connected to the AXIS 213’s connection module to any web clients. It will not receive audio from any other web clients. This can be used in remote monitoring, web attractions etc., to provide live audio, as well as video, of a monitored situation.

When using half-duplex, the **Send the sound from the active client to all other clients** option transmits the audio signal from the client that is talking to all the other clients.

**Audio Input**

If there are problems with the sound input being too low or high, it is possible to adjust the input gain for the microphone connected to the AXIS 213.

**Audio Output**

If the sound from the speaker is too low or high it is possible to adjust the **output gain** for the active speaker connected to the connection module.

When satisfied with the settings, click **Save**, or click **Reset** to revert to the previously saved settings.
Advanced Audio Settings

The **Advanced Audio** settings allows you to tune the external microphone connected to the **AXIS 213**'s connection module to suit your environment.

Enable speech filter improves the sound quality when the microphone is placed close to the person talking and can also help reduce background noise. The filter cuts the lowest and the highest frequencies. The bypass frequency range is approximately 250Hz to 3700Hz (measured at -10dB cut-off break points).

Enable echo cancellation reduces acoustic echoing if sound from the speaker is captured by the microphone.

Noise canceling is a way of reducing the background noise when there is no useful audio present. A typical application could be that the camera is set up in a noisy environment, and you are only interested in hearing the sound from the **AXIS 213** when someone is speaking close to the microphone. There are two adjustable parameters available to optimize this function:

- **Noise canceller threshold value**
- **Noise canceller attenuation**

When the incoming sound is louder than the threshold, it will pass without any changes. When lower than the threshold, the incoming sound will be reduced by a certain attenuation factor. The threshold level should be set higher than the background noise, but lower than the useful audio.
The noise canceller threshold value can be set to High, Medium High, Medium low and Low. A lower threshold will accept most of the audio to pass. Only the weakest background noise will be reduced. A higher threshold will make the noise canceller act on even stronger background noise. At the maximum level High, there is a risk of reducing useful audio as well.

There is a trade-off between noise canceling and sound quality. In other words, increasing the noise canceller attenuation deteriorates sound quality. Adjust the threshold and the attenuation to an optimum by listening and changing the levels.
Live View Config - Live View Layout

These are the tools for deciding the layout of the Live View page. The layout can be set in 3 ways:

- **Use Axis look** - the layout is unchanged.
- **Use custom settings** - modify the default page with your own colors, images etc. Click the **Configure** button and see the following page.
- **Own Home Page** - Upload and use your own custom made page as the default web page. Click the **Configure** button and see the following page.

### Use custom settings

Adjust the settings under **Modify the Axis look**, to change the background picture, banner, colors, etc.

To use your own file for e.g. a banner, first upload it (see the following page) or select **External** and enter the path to the file.

Note that unchecking the box for **Show setup link** will remove the setup link from the camera’s Home Page. The setup tools will then only be accessible by entering the full setup address into the
address/URL field of a browser, i.e.

http://<ip address>/operator/basic.shtml

Upload Own Web Files

Your own web files, background picture, color etc. must first be uploaded to the AXIS 213 in order to be available for selection in the Custom Settings setup dialog. Once uploaded, the files are shown in the drop-down list.

1. Enter the path to the file, e.g. a file located on your workstation or click the Browse button.
2. Select the user level for the uploaded file. Setting the user access level means that you have complete control over which pages can be viewed by which users.
3. When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, check the box provided next to it and then click the Remove button.

- To use your uploaded file, click the radio button and select the file from the drop-down list by Own:
- To use an external file located somewhere other than in the AXIS 213, click the radio button and enter the URL by External:
Own Home Page

To use a previously uploaded web page as the default page, check the checkbox, select the page from the drop-down list and click **OK**.

User Defined Links

Enter a descriptive name and enter the URL in the provided field. The link will appear on the **Live View** page.

User defined CGI links can be used to issue HTTP API requests, e.g. PTZ commands.

Example:

1. Check **Show Custom Link 1**
2. Enter a descriptive name, e.g. CAM START.
3. Select the **Use as cgi link** radio button and enter the cgi link in the field:


4. Check **Show Custom Link 2**.
5. Enter a descriptive name, e.g. CAM STOP.
6. Select the **Use as cgi link** radio button and enter the cgi link in the field:

   ![http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=0,0]

7. These links will appear in the web interface and can be used to control the PTZ camera.

For more information on the Axis HTTP API, see the Support / Developer pages on the Axis Website at http://www.axis.com

Action Buttons - These buttons can then be used to manually trigger and stop an event from the Live View page. See Event Servers, on page 34. The snapshot button allows users to take a snapshot of the video stream and save it on a computer.
**Output Buttons** - These buttons can then be used to manually start and stop an event from the Live View page, e.g. switch a light on/off:

- The Pulse button activates the port for a defined period
- Active/Inactive displays 2 buttons, one for each action (on/off)

**Default Video Format in Internet Explorer for Windows** - Select default video format from the drop-down list. Check the box to enable video format selection on the Live View Page. When using MPEG-4 as video format, the default viewer is AXIS Media Control with Internet Explorer.

**AMC Settings** - Uncheck the **Show viewer toolbar** checkbox to remove the AMC (Axis Media Control) viewer toolbar under the image on the live view page. Uncheck the **Enable MPEG-4 decoder installation** checkbox disable the installation of the MPEG-4 decoder included with AMC. Check the **Show red cross in PTZ joystick mode** checkbox to show a red position indicator on the live view page when the joystick navigation mode is selected.

**Default Viewer for your Browser** - select the appropriate radio button to define your method for viewing moving images depending on your Web browser and settings.

Please use the online help files for details.

---

**HTML Examples**

You can add live video from your AXIS 213 to your own website. The AXIS 213 can send Motion-JPEG to up to 20 simultaneous connections, although an administrator can restrict this to fewer. If MPEG-4 is set as video format, multicasting is used and the video stream will be available for an unlimited number of viewers connected to the parts of the network where multicast is enabled. Please note that a separate MPEG-4 license is required for each viewer.

It is possible to select the **Image Type**, **Image size** and **Optional settings** to suit your Web page when using Motion JPEG.

Copy the source code as displayed on the HTML examples page and paste it into your own HTML code.

Please see the online help for more information.
PTZ Configuration

Preset Positions
A preset position is a pre-defined camera view than can quickly and easily be viewed.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera to the required position. When satisfied with the camera's position, enter a descriptive name. This camera position is then saved as a preset position.

The AXIS 213 will take the exact position when the preset's name is selected from the Preset positions drop-down list. Preset positions can be selected in Live View, from events and in Sequence mode.

One position can be set as the Home position, which is readily accessible by clicking on the Home button in both the Preset Position Setup window and the Live View window. The position's name will have (H) added, e.g. Office Entrance (H).

Sequence Mode
The Live View page can be configured to rotate through the selected preset positions, in a set order or randomly.

Select the desired preset positions and enter the time to display each position. Click Save.

The Sequence buttons will appear on the Live View page to enable the viewer to start and stop the sequence mode.
Advanced - Limits

Define the **pan**, **tilt** and **zoom** limits for the AXIS 213. Movements to the left and right, up and down can be restricted to narrow the area under surveillance.

**Move speed** sets the speed of the camera's Pan/Tilt movements. The default setting is maximum speed.

Control Queue

**PTZ Control Queue** - The administrator can set up a queue for the PTZ controls. Once set up, the PTZ Control Queue buttons will appear on the Live View page offering one viewer exclusive control for a limited amount of time. Other users will be placed in the queue.

![PTZ Control Queue on Live View page](image)

Please see the online help 🔄 for more information.
Event Configuration

This section describes how to configure the AXIS 213 for alarm and event handling. The AXIS 213 can be configured to perform certain actions when certain types of events occur.

Event Type

<table>
<thead>
<tr>
<th>Triggered Event page 35</th>
<th>e.g. at a signal from an external device, such as a door switch or a sensor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled Event page 37</td>
<td>e.g. at a pre-programmed time</td>
</tr>
<tr>
<td>Action</td>
<td>e.g. uploaded video images to an FTP server, email notification, etc.</td>
</tr>
</tbody>
</table>

Event Servers

Event Servers are used, e.g. for receiving uploaded image files and/or notification messages. To set up Event server connections in your AXIS 213, go to Setup > Event Configuration > Event Servers and enter the required information according to the selected server type.

<table>
<thead>
<tr>
<th>Server type</th>
<th>Purpose</th>
<th>Requires information</th>
</tr>
</thead>
</table>
| FTP Server   | • used for uploading saved images               | • Descriptive name of your choice  
• User Name and Password (to FTP server)  
• Upload path e.g. images/  
• Port number  
• Use passive mode if there is a firewall between the PTZ camera and the FTP server |
| HTTP Server  | • used for notification messages  
• used for uploading saved images | • Descriptive name of your choice  
• URL  
• User Name and Password (to HTTP server)  
• Proxy address/Proxy port (if required)  
• Proxy User Name and Password (if required) |
| TCP Server   | • used for notification messages                | • Descriptive name of your choice  
• User Name and Password (to TCP server)  
• Port number |

For details on each setting, please refer to the online help files which are available from each web page.

Note: Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the connection test will take approximately 10 seconds).
**Event Types**

An **Event Type** is a set of parameters describing how and when the AXIS 213 is to perform certain actions.

**Example:** If somebody passes a connected sensor and an event type has been configured to act on this, the camera can e.g. record and save images to an FTP server, and/or send a notification email to a pre-configured email address with a pre-configured message. Images can be sent as email attachments.

**Triggered Event**

A Triggered event is activated from, e.g:

- a switch connected to an input port on the AXIS 213
- a manually activated action e.g. from an action button in the web interface
- on restart (reboot) after e.g. power loss

**How to set up a triggered event**

This example describes how to set the AXIS 213 to upload images when the main door is opened:

1. Click **Add triggered** on the **Event types** page.
2. Enter a descriptive **name** for the event, e.g. Main door.
3. Set the **Priority** - High, Normal or Low (see online help files).
4. Set the **Respond to Trigger...** parameters when the event is to be active, e.g. only after office hours
5. Select the trigger alternative from the **Triggered by...** drop-down list, e.g. an Input port with a connected sensor if the door is opened.
6. Set the **When Triggered...** parameters i.e. set what the AXIS 213 is to do if the main door is opened e.g. upload images to an FTP server.
7. Click **OK** to save the Event in the Event Types list.
Please use the online help files for descriptions of each available option.

**Pre-trigger and Post-trigger buffers**
This function is very useful when checking to see what happened immediately before and after a trigger, e.g. 2 minutes before and after a door has been opened. Check the **Upload images** checkbox under **Event Types > Add Triggered... > When Triggered...** to expand the web page with the available options.

**Note:** **Buffer size** - up to 9 MB buffer. The maximum length of time of the pre-/post-buffer depends on the image size and selected frame rate.

**Include pre-trigger buffer** - images stored internally in the server from the time immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the desired length of time and specify the required image frequency.

**Include post-trigger buffer** - contains images from the time immediately after the trigger. Configure as for pre-trigger.

**Note:** If the pre- or post-buffer is too large for the internal memory, the frame rate will be reduced and individual images may be missing. If this occurs, an entry will be created in the unit's log file.

**Continue image upload (unbuffered)** - enable the upload of images for a fixed length of time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, or for as long as the trigger is active. Finally, set the desired image frequency to the maximum (the maximum available) or to a specified frame rate. The frame rate will be the best possible, but might not be as high as specified, especially if uploading via a slow connection.
Scheduled Event
A **Scheduled event** can be activated at pre-set times, in a repeating pattern on selected weekdays.

**How to set up a scheduled event**
This example describes how to set the AXIS 213 to send an email notification with saved images from a set time:

1. Click **Add scheduled** on the **Event types** page.
2. Enter a descriptive **name** for the event, e.g. Scheduled email.
3. Set the **Priority** (High, Normal or Low).
4. Set the **Activation Time** parameters (24h clock) when the event is to be active, e.g. start on Fridays at 18.00 with a duration of 62 hours.
5. Set the **When Activated...** parameters i.e. set what the AXIS 213 is to do at the specified time e.g. send uploaded images to an email address.
6. Click **OK** to save the Event in the Event Types list.

Please use the online help files 🛠 for descriptions of each available option.

**Motion Detection**
In the **Motion Detection** menu, you can configure the AXIS 213 for motion detection. The motion detection feature is used to generate an alarm whenever movement occurs (or stops) in the image. The AXIS 213 can use a maximum of 10 **Include/Exclude windows**.

- **Include** windows target specific areas within the image
- **Exclude** windows are areas to be ignored within the Include window

Once configured, the motion detection windows will appear in a list when motion detection is selected to trigger an event. See **How to set up a triggered event** above.

**Note:** Using the motion detection feature may decrease overall performance in the camera. Motion detection will not function while the lens is moving (i.e. pan, tilt, zoom)

**How to configure Motion Detection**
This example describes how to configure motion detection:

1. Click **Motion Detection** in the **Event Configuration** menu.
2. Click the **Configure Included Windows** radio button.
3. Click **New**.

4. Enter a descriptive name of your choice under **Windows name**.

5. Adjust the size (drag the bottom right-hand corner) and position (click on the text at the top and drag to the desired position).

6. Adjust the Object size, History and Sensitivity profile sliders (see table below for details). Any detected motion within an active window is then indicated by red peaks in the **Activity** window (the active window has a red frame).

7. Click **Save**.

If there are parts of the Include window that you wish to exclude, click the **Configure Excluded Windows** radio button and repeat steps 1-8 above.

Please use the online help 🎨 for descriptions of each available option.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Size</th>
<th>History</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Only very large objects trigger motion detection</td>
<td>An object that appears in the region will trigger the motion detection for a long period</td>
<td>Ordinary colored objects against ordinary backgrounds will trigger the motion detection</td>
</tr>
<tr>
<td>Low</td>
<td>Even very small objects trigger motion detection</td>
<td>An object that appears in the region will trigger motion detection for only a very short period</td>
<td>Only very bright objects against a dark background will trigger motion detection</td>
</tr>
<tr>
<td>Default values</td>
<td>Low</td>
<td>Medium to High</td>
<td>Medium to High</td>
</tr>
</tbody>
</table>

**Examples:**

- Avoid triggering on small objects in the image by selecting a high **size** level.
- To trigger motion detection as long as there is activity in the area, select a high **history** level.

To only detect flashing light, low **sensitivity** can be selected. In other cases, a high **sensitivity** level is recommended.

**Port Status**

Under **Event Configuration > Port Status** there is a list that shows the status for the connected inputs and outputs of the AXIS 213 for the benefit of the Operator who cannot access the System Options section.

**Example:** If the Normal state for a push button connected to an input is set to **Inactive** - as long as the button is not pushed, the state is **inactive**. If the button is pushed, the state of the input changes to **active**.
System Options

Security

User access control is enabled by default, the administrator sets the root password on first access. Other users are authorized with user names and passwords, or the administrator can choose to allow anonymous viewer login to the Live View page, as described below:

Users - the user list displays the authorized users and access levels:

- **Viewer** - the lowest level of access, which only allows the user access to the Live View page.
- **Operator** - an Operator can view the Live View page, create and modify event types and adjust certain other settings. The Operator does not have access to the Systems Options configuration pages.
- **Administrator** - an administrator has unrestricted access to the Setup Tools and can determine the registration of all other users.

User Settings - check the corresponding checkboxes to enable:

- **Anonymous viewer login** - allows any viewer direct access to the Live View page.
- **Maximum number of simultaneous viewers** - enter a value here to restrict the number of unicast viewers accessing the unit. This is useful if you need to save on bandwidth. (Note that all multicast viewers count as 1 viewer.)
- **Anonymous PTZ control login** - allows any viewer access to the Pan/Tilt/Zoom controls on the Live View page.

IP Address Filtering - The administrator can add up to 256 IP address ranges or single IP addresses to the Allowed IP Addresses list. If IP address filtering is enabled, the AXIS 213 will allow or deny requests coming from the IP addresses in the list.

See the IP address filtering help files 🚀 for information on how to add IP address ranges.

The users from these IP addresses need to be specified in the user list with the appropriate access rights (**User**, **Operator** or **Administrator**).
Referrals - to prevent unauthorized sources from including the video stream from the AXIS 213 into external Web pages, check the **Referrals** checkbox and enter the IP address or Host name of the computer that hosts the Web pages with the included video stream. Several IP addresses/host names can be defined and are separated by semicolons(;)

**Date & Time**

**Current Server Time** - displays the current date and time (24h clock). If this has not been configured, the time displayed is the default setting. The time can be displayed in 12h clock format in the Overlay Images (see below).

**New Server Time** - Select your time zone from the drop-down list and check the daylight saving time changes, if desired.

From the **Time Mode** section, select the preferred method to use for setting the time:

- **Synchronize with computer time** - sets the time from the clock on your computer.
- **Synchronize with NTP Server** - the AXIS 213 will obtain the time from an NTP server every 60 minutes. Specify the NTP server's IP address or host name. Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. See Network > TCP/IP below.

**Set manually** - this option allows you to manually set the time and date.

**Date & Time Format Used in Images** - specify the formats for the date and time (12h or 24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See **Advanced File Naming & Date/Time Formats** in the help files 📘 for information on how to create your own file formats.

**Network**

**Basic TCP/IP Settings**

**IP Address Configuration** - the IP address of the AXIS 213 can be set automatically via DHCP, or a fixed IP address can be set manually. A host name can be used and there are options for setting up notification of changes in the IP address. DHCP is enabled by default.

**Note:** Automatic IP address assignment via DHCP may lead to the situation where the IP address is
changed and you lose contact. Configure the **options for notification of IP address change** (under **Services**) to receive notification from the AXIS 213, when the IP address has been changed.

Alternatively, if your DHCP server can update a **DNS server**, you can access the AXIS 213 by host name which is always the same, regardless of the IP address.

**Services**

**Options for notification of IP address change** - if the IP Address for the AXIS 213 is changed automatically, e.g. by DHCP, you can choose to be notified. Click **Settings**... and enter the required information.

**AXIS Internet Dynamic DNS Service** - If the AXIS 213 has been registered with the Axis Internet Dynamic DNS service and the IP address for the product changes, the service is updated to reflect the change. Check the box to enable/disable automatic updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your product can at any time be removed. To do this click **Settings**... and follow the instructions.

For more information, please refer to the online help files 🛠

**Advanced TCP/IP Settings**

**DNS Configuration** - DNS (Domain Name Service) provides the translation of host names to IP addresses on your network.

**Obtain DNS server address via DHCP** - automatically use the DNS server settings provided by the DHCP server. Click the **View** button to see the current settings.

**Use the following DNS server address** - enter the desired DNS server by specifying the following:

- **Domain name** - enter the domain(s) to search for the host name used by the AXIS 213. Multiple domains can be separated by semicolons (;). The host name is always the first part of a Fully Qualified Domain Name, e.g. myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com where mycompany.com is the Domain name.
- **Primary DNS server** - enter the IP address of the primary DNS server.
- **Secondary DNS server** - will be used if the primary DNS server is unavailable.
NTP Configuration - The AXIS 213 can obtain the correct time from an NTP server. The address for the NTP server can either be obtained via the DHCP server, or it can be entered manually.

Host Name Configuration - The AXIS 213 can be accessed using a host name, instead of an IP address. The host name is usually the same as the assigned DNS Name. It is always the first part of a Fully Qualified Domain Name and is always one word, with no period. For example, myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com.

The enable dynamic DNS updates allows you to alias a dynamic IP address to a static host name, allowing your computer to be more easily accessed from various locations on the Internet. Outside users can always access your server using the associated DNS name regardless of the WAN IP. The DNS server used by the user and/or the DNS server responsible for the domain in use must support RFC2136 and allow updates from the camera.

The TTL (Time To Live) value determines how long (in seconds) the reply from the DNS server should be remembered when checking that the domain name for the registered IP address is still valid.

- Link-Local Address is enabled by default and assigns the AXIS 213 with an additional IP address for the UPnP protocol. The AXIS 213 can have both a Link-Local IP and a static/DHCP IP address at the same time - these will not affect each other. See Network - UPnP, on page 44.

HTTP

The default HTTP port number (port 80) can be changed to any port within the range 1024-65535. This is useful for e.g. simple security port mapping.

NAT Traversal

Use NAT traversal when your AXIS 213 is located on an intranet (LAN) and you wish to make it available from the other (WAN) side of a NAT router. With NAT traversal properly configured, all HTTP traffic to an external HTTP port in the NAT router will be forwarded to the network camera.

Enable/Disable - When enabled, the AXIS 213 will attempt to configure port mapping in a NAT router on your network, using UPnP™.
Use manually selected NAT router - Select this option to manually select a NAT router. Enter the IP address for the router in the field provided. If a router is not manually specified, the AXIS 213 Network Camera will automatically search for NAT routers on your network. If more than one router is found, the default router will be selected.

Alternative HTTP port - Select this option to manually define an external HTTP port. Enter the port number in the field provided. If no port is entered here, a port number will automatically be selected when NAT traversal is enabled.

RTSP

The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP port number to use. The default setting is 554.

Network Traffic

The default setting is Auto-negotiate which means that the correct speed is automatically selected. If necessary, you can set the connection speed by selecting it from the drop-down list. 10BaseT (Half/Full Duplex), 100BaseTX (Half/Full Duplex).

Maximum bandwidth - Specify, in Mbit/s or Kbit/s, the maximum bandwidth that the AXIS 213 is allowed to use on your network. This is a useful function when connecting the AXIS 213 to busy or heavily loaded networks. The default setting is Unlimited.

For more information, please refer to the online help files 📚

Network - SOCKS

SOCKS is a networking proxy protocol. The AXIS 213 can be configured to use a SOCKS server to reach networks on the other side of a firewall/proxy server. This functionality is useful if the AXIS 213 is located on a local network behind a firewall, but notifications, uploads, alarms, etc., need to be sent to a destination outside the local network (e.g. to the Internet).

Network - SMTP (email)

(Simple Mail Transfer Protocol) Enter the host names or addresses for your primary and secondary mail servers in the fields provided to enable event and error email messages from the AXIS 213 to predefined addresses, via SMTP.
**Network - UPnP**

The AXIS 213 includes support for UPnP in Windows Millennium and Windows XP. UPnP is enabled by default.

**Note:** UPnP must be installed on your workstation. To do this, open the Control Panel from the **Start Menu** and select **Add/Remove Programs**. Select **Add/Remove Windows Components** and open the **Networking Services** section. Click **Details** and then select **UPnP** as the service to add.

**RTP/MPEG-4**

Multicast must be enabled for these settings to take effect. The settings are only valid when MPEG-4 is used as the video format. These settings are the port range, IP address, port number, and Time-To-Live value to use for the video stream(s) in MPEG-4 format. Only certain IP addresses and port numbers should be used for multicast streams.

Enter the port range, IP address and the port number to use for the video and audio streams in the required fields.

Only IP addresses within certain ranges can be used for multicasting. The camera has been pre-configured with an address from these ranges, and this does not normally need to be changed. Please contact your network administrator if you have special requirements.

**Notes:**

- Viewers do not need to know this IP address or port number, but simply the main IP address or host name otherwise used for accessing the camera.
- Setting the video port number to 0 means a random port number will be used.

If IP packets (i.e. data) fail to be delivered to their destination within a reasonable length of time the number entered in the Time to live field tells the network routers when to discard the packet. The value is usually measured in ‘hops’, i.e. the number of network routers that can be passed before the packet arrives at its destination or is dropped.

**Ports & Devices - I/O Ports**

The pinout, interface support and the control and monitoring functions are described in the section on the Connection Module, on page 48.
LED Settings

When the LED on the front of the AXIS 213 is Enabled, the LED will remain lit when the AXIS 213 is on and flash when there is any network activity. If Disabled, the LED will remain off, except when there is a hardware problem and the LED will flash red.

Maintenance

• **Restart** - The unit is restarted without changing any of the settings. Use this method if the unit is not behaving as expected.

• **Restore** - The unit is restarted and most current settings are reset to factory default values. The settings that will not be reset are as follows:
  • the boot protocol (DHCP or static)
  • the static IP address
  • the default router
  • the subnet mask
  • the system time

**Default** - The Factory default button should be used with caution. Pressing this button will reset all of the AXIS 213's settings to the factory default values (including the IP address)

Upgrade Server - See Updating the Firmware, on page 50.

Backup - click the Backup button to take a backup of all of the parameters, and any user-defined scripts. If necessary, it is then possible to return to the previous settings if the settings are changed and there is unexpected behavior.

**Note:** The root password will also be reset to the password saved in the backup file.

Restore - click the Browse button to locate the saved backup file (see above) and then click the Restore button. The settings will be restored to the previous configuration.

**Note:** Backup and Restore can only be used on the same unit running the same firmware. This feature is not intended for multi-configurations or for firmware upgrades.
Support
The **support overview** page provides valuable information on troubleshooting and contact information, should you require technical assistance.

**System Overview** - this page provides an overview of the camera’s settings and the most recent log entries with links to the corresponding pages.

**Logs & Reports** - when contacting Axis support, please be sure to provide a valid Server Report with your query.

**View Information** - The **Log** report and the **Parameter List** also provide valuable information for troubleshooting and when contacting Axis’ support service.

Configuration

- **Log Level for Log Files** - from the drop-down list, select the level of information to be added to the Log file
- **Log Level for Email** - from the drop-down list, select the level of information to send as email and enter the destination email address.

Advanced
Scripting is an advanced function that provides the possibility to customize and use scripts. This function is a very powerful tool.

**Caution!**
Improper use may cause unexpected behavior or even cause loss of contact with the unit. If a script does cause problems, reset the unit to its factory default settings. A backup file may be of use to return the unit to its latest configuration.

**Axis strongly recommends that you do not use this function unless you fully understand the consequences.** Note that Axis support does not provide assistance for problems with customized scripts.

For more information, please visit the Developer pages at [www.axis.com/developer](http://www.axis.com/developer)

**Plain Config** - this function is for the advanced user with experience of Axis network camera configuration. All parameters can be set and modified from this page. Help is available from the standard help pages.
Resetting to Factory Default Settings

To reset the AXIS 213 to the original default settings, go to the System Options > Maintenance web page (described in Maintenance, on page 45) or use the Reset button on the AXIS 213 as described below:

Using the Reset Button
Follow the instructions below to reset the AXIS 213 to factory default settings using the Reset Button.

1. Switch off the AXIS 213 by disconnecting the external power supply.
2. Using a suitably pointed object, press and hold the Reset button while you reconnect the power connector.
3. Keep the Reset button pressed for approximately 15 seconds.
4. Release the Reset button.

Note: Resetting to the factory default settings using the Reset Button will cause all parameters (including the IP address) to be reset. Refer to Maintenance, on page 45 for other methods that do not reset the IP address.
Connection Module

The connection module connects to the camera and is configured and controlled via the camera’s user interface. The Connection module is an optional accessory providing the following:

- audio in / out
- 3 relay outputs
- 2 digital inputs
- video in / out
- RS-232C Serial port

Installing the audio equipment

1. Connect a microphone (not supplied) to the Audio IN socket.
2. Connect a loudspeaker (not supplied) to the Audio OUT socket (amplified speakers only).

I/O inputs and outputs

The I/O inputs / outputs are used in applications for, e.g. event triggering, time lapse recording, alarm notification via email, picture storage to FTP locations.

- **Input** - e.g. a doorbell. If the doorbell is pressed, the state changes, and the input will be active (shown under Event Configuration > Port Status).
- **Output** - e.g. an alarm device that can be activated from Output buttons on the Live View page, or as an action for an Event Type. The output will show as active (under Event Configuration > Port Status) if the alarm device is activated.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm In 1,2</td>
<td>Connect to GND to activate or leave floating (unconnected) to deactivate</td>
</tr>
<tr>
<td>Alarm GND</td>
<td></td>
</tr>
<tr>
<td>Alarm Out 1A,1B;2A,2B;3A,3B</td>
<td>Active output, electrical connection between A and B. Non active output, no connection between A and B. Imax=100mA, Vmax=24V</td>
</tr>
</tbody>
</table>

Video Out

Via a standard BNC connector, this output allows the AXIS 213 to be connected directly to traditional CCTV systems. **Video In** and **RS-232C** can be configured under Plain config for use in advanced applications (see System Options > Advanced > Plain Config). Intended for advanced users only.
Troubleshooting

Checking the Firmware

The firmware is software that determines the functionality of the AXIS 213. When you download firmware from the Axis Website, your Axis product will receive the latest available functionality.

One of your first actions when troubleshooting a problem should be to check the currently installed firmware version. The latest version may contain a correction that fixes your particular problem. The current software version in your AXIS 213 is available under Setup > Basic Configuration.

Updating the Firmware

New firmware can be downloaded to the AXIS 213 over the network. Always read the upgrade instructions available with each new release, before updating the firmware.

1. Save the firmware file to your computer. The latest version of the AXIS 213 firmware is available free of charge from the Axis Website at http://www.axis.com/techsup or from your local distributor.
2. Go to Setup > System Options > Maintenance in the AXIS 213 Web pages.
3. In the Upgrade Server section and browse to the firmware file on your computer. Click Upgrade.
4. Wait at least 20 minutes before restarting the AXIS 213 after upgrading.

Notes:
- Pre-configured and customized settings will be retained for use when the new firmware is running (providing that the features are available in the new firmware) although this is not guaranteed by Axis Communications.
- After starting the process, you should always wait at least 20 minutes before restarting the AXIS 213, even if you suspect the procedure has failed.
- Your dealer reserves the right to charge for any repair attributable to faulty updating by the user.
Support

If you contact the Axis support desk, please help us help you resolve your problems expediently by providing a server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report contains important information about the server and its software, as well as a list of the current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events within the unit since the last restart of the system and can prove a useful diagnostic tool for troubleshooting.
**Symptoms, Possible Causes and Remedial Actions**

### Problems setting the IP address

<table>
<thead>
<tr>
<th>Using ARP Ping</th>
<th>The IP address must be set within two minutes after the power has been applied to the AXIS 213, restart the server and try again. Also, make sure the ping length is set to 408.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The AXIS 213 is located on a different subnet</td>
<td>If the IP address intended for the AXIS 213 and the IP address of your computer are located on different subnets, you will not be able to set the IP address. Contact your network administrator for an IP address on the same subnet as the computer you are performing the installation from.</td>
</tr>
</tbody>
</table>
| The IP address is being used by another device | **Disconnect power from the AXIS 213.** Run the Ping command (in a Command/DOS window, type `ping` and the **IP address** of the unit).  
If you receive: **Reply from <IP address>: bytes = 32; time = 10 ms.....** - this means that the IP address may already be in use by another device on your network. You must obtain a new IP address and reinstall the unit.  
If you receive: **Request timed out** - this means that the IP address is available for use with your AXIS 213. In this case, check all cabling and reinstall the unit. |

### The AXIS 213 cannot be accessed from a browser

| The IP address has been changed by DHCP | 1) Move the AXIS 213 to an isolated network or to one with no DHCP or BOOTP server. Set the IP address again, using the ARP Ping command.  
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the main network. The unit now has a fixed IP address that will not change.  
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the required service and then configure IP address change notification from the network settings. Return the unit to the main network. The unit will now have a dynamic IP address, but will notify you if the address changes. |
| Other networking problems | Test the network cable by connecting it to another network device, then Ping that device from your workstation. |

### Cannot send notifications, uploads, alarms, etc, to a destination outside the local network.

| Firewall protection | The AXIS 213 can be configured to use a SOCKS server to reach networks on the other side of a firewall/proxy server. |

### Your AXIS 213 is accessible locally, but not externally

| Firewall protection | Check the Internet firewall with your system administrator. |
| Default routers required | Check if you need to configure the default router settings. |
| The Internet site is too heavily loaded | Use a script running on your web server to relay images from the AXIS 213 to the Internet. |

| A firmware upgrade has been interrupted or the firmware has in some other way been damaged | A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP and Ping.  
Then, from a Web browser, access the unit and download the latest firmware to the product, see Updating the Firmware, on page 50. |
### Problems with the MPEG-4 format

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No MPEG-4 displayed in the client.</td>
<td>Check that the correct network interface is selected in the AMC control panel applet (network tab). Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel applet (network tab). In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 decoder.</td>
</tr>
<tr>
<td>No multicast MPEG-4 displayed in the client.</td>
<td>Check with your network administrator that the multicast addresses used by the AXIS 213 are valid for your network. Check with your network administrator to see if there is a firewall preventing viewing.</td>
</tr>
<tr>
<td>Multicast MPEG-4 only accessible by local clients.</td>
<td>Check if your router supports multicasting, or if the router settings between the client and the server need to be configured. The TTL (Time To Live) value may need to be increased.</td>
</tr>
<tr>
<td>Poor rendering of MPEG-4 images</td>
<td>Color depth set incorrectly on clients. Set to 16-bit or 32-bit color. If text overlays are blurred, or if there are other rendering problems, you may need to enable Advanced Video Rendering from the MPEG-4 tab in the AMC control panel applet. Ensure that your graphics card is using the latest device driver. The latest drivers can usually be downloaded from the manufacturer's website.</td>
</tr>
<tr>
<td>Color saturation is different in MPEG-4 and Motion JPEG.</td>
<td>Modify the settings for your graphics adapter. Please see the adapter's documentation for more information.</td>
</tr>
<tr>
<td>Lower frame rate than expected.</td>
<td>Reduce number of applications running on the client computer. Check with the system administrator that there is enough bandwidth available. See also the online help. Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode only I frames. Lower the image resolution.</td>
</tr>
<tr>
<td>Image degeneration.</td>
<td>Decrease the GOV length, see the online help for more information.</td>
</tr>
</tbody>
</table>

### No images displayed in the Web interface

| Problem with AMC (Internet Explorer only) | To enable the updating of images in Microsoft Internet Explorer, set your Web browser to allow ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on your workstation. |
| Installation of additional ActiveX component restricted or prohibited | Configure your AXIS 213 to use a Java applet for updating the images under Live View Config > Layout > Default Viewer for Internet Explorer. See help files for more information. |

### Video Image Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image too dark or too light</td>
<td>See the help on Video &amp; Image Settings.</td>
</tr>
<tr>
<td>Problems uploading own files</td>
<td>There is only limited space available for the upload of your own files. Try deleting one or more existing files, to free up space.</td>
</tr>
<tr>
<td>Missing images in uploads</td>
<td>This can occur when trying to use a larger image buffer than is actually available. Try lowering the frame rate or the upload period.</td>
</tr>
<tr>
<td>Slow image update</td>
<td>Configuring, e.g. pre-buffers, hi-res images, high frame rate etc will reduce the performance of the AXIS 213.</td>
</tr>
<tr>
<td>Slow performance</td>
<td>Slow performance may be caused by e.g. heavy network traffic, many users with access to the unit, low performing client, use of features such as Event handling., Image rotation.</td>
</tr>
</tbody>
</table>
### Bad snapshot images

<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display incorrectly configured on your workstation</td>
<td>In Display Properties, configure your display to show at least 65536 colors, i.e. at least 16-bit. Using only 16 or 256 colors on your display will produce dithering artifacts in the image.</td>
</tr>
</tbody>
</table>

### Audio problems

<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
</table>
| No audio | Check that:  
- PC sound card, speakers and microphone are correctly connected  
- the Mute button is not pressed  
- the volume in and volume out settings are correct  
- all cabling is connected  
- the value of the Post Content Length in your proxy server is 1MB or more. You may need to contact your system administrator to do this. |
| No full-duplex function | Incorrect configuration. Check the setting in the camera’s Setup pages. Sound card does not support full-duplex. For information on how to check if your sound card supports full-duplex, please visit [www.axis.com](http://www.axis.com) and see the support section for Axis camera products. |
| Poor performance | Too many users/clients connected. Try limiting the number of clients allowed to connect. Low bandwidth. Reduce the Speed setting on the Audio settings page. Setting lower speed will reduce any break-up in the sound, but will also increase the transmission delay. If running in Full-Duplex mode, try switching to Half-Duplex mode. |
| Whining or screeching sound from speakers (feedback) | Poor positioning of speakers and/or microphone. Relocate the speakers or microphone so that they do not point towards each other, and/or lower the volume. |

For additional assistance, please contact your reseller or check the product’s support pages on the Axis Website at [http://www.axis.com/techsup](http://www.axis.com/techsup)
# Technical Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
</table>
| **Models**                   | • AXIS 213 PTZ 50Hz (PAL)  
• AXIS 213 PTZ 60Hz (NTSC)  
Supports both desktop and ceiling mounting |
| **Video compression**        | Motion-JPEG. Snapshot JPEG images available. User-controlled compression level. MPEG-4. User controlled profile. |
| **Resolutions**              | 4CIF, 2CIFExp, 2CIF, CIF, QCIF max 704x480 (NTSC) 768x576 (PAL) min 160x120 (NTSC) 176x144 (PAL) |
| **Frame rate**               | • Motion JPEG: Up to 30/25 fps at 4CIF  
• MPEG-4: Up to 30/25 fps at 2CIF |
| **Video streaming**          | • Simultaneous Motion JPEG and MPEG-4  
• Controllable frame rate and bandwidth  
• Constant and variable bit rate (MPEG-4) |
| **Image settings**           | • Compression levels: 11 (Motion JPEG) /23 (MPEG-4)  
• Rotation: 90°, 180°, 270°  
• Aspect ratio correction  
• Backlight compensation, exposure, white balance  
• Color and black/white mode  
• Overlay capabilities: time, date, text or image  
• De-interlace filter |
| **Image sensor**             | 1/4” Interlaced CCD |
| **Lens**                     | • 3.5 - 91 mm, F1.6 – F4.0, motorized zoom lens, horizontal viewing angle: 42 - 1.7°, auto focus, 26x optical and 12x digital zoom |
| **Minimum illumination**     | • Color mode: 1 lux, F1.6  
• IR mode: compete darkness using built-in IR lighting up to 3 m (9.8 ft) |
| **Security**                 | • Multiple user access levels with password protection  
• IP address filtering |
| **Alarm and event management** | • Events triggered by built-in motion detection, external inputs or according to a schedule  
• Image upload over FTP, email and HTTP  
• Notification over TCP, email, HTTP and external outputs  
• Pre- and post alarm buffer of 6 MB |
| **Connectors**               | • Ethernet 10BaseT/100BaseTX, RJ-45  
• 26-pin multi-connector (to optional Connection Module) |
| **Processors, memory, clock** | • CPU: ETRAX 100LX 32-bit RISC CPU  
• Video processing and compression: ARTPEC-2  
• RAM: 32 MB  
• Flash: 4 MB |
| **Power**                    | • 13 V DC, max 24W external power supply |
### Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating conditions</strong></td>
<td>• 5 - 40 ºC (41 – 104 ºF)</td>
</tr>
<tr>
<td></td>
<td>• Humidity 20 - 80% RH (non-condensing)</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>G.711 PCM 64kbit/s, G.726 ADPCM 32 or 24 kbit/s, full duplex, half duplex,</td>
</tr>
<tr>
<td></td>
<td>simplex or audio off</td>
</tr>
<tr>
<td><strong>Installation, management and maintenance</strong></td>
<td>• Installation tool on CD and web-based configuration</td>
</tr>
<tr>
<td></td>
<td>• Configuration backup and restore</td>
</tr>
<tr>
<td></td>
<td>• Firmware upgrades over HTTP or FTP over TCP/IP, firmware available at <a href="http://www.axis.com">www.axis.com</a></td>
</tr>
<tr>
<td><strong>Video access from Web browser</strong></td>
<td>Camera live view for up to 20 clients, sequence tour capability</td>
</tr>
<tr>
<td><strong>Minimum web browsing requirements</strong></td>
<td>• Pentium III CPU 500 MHz or higher, or equivalent AMD Athlon Memory</td>
</tr>
<tr>
<td></td>
<td>• 128 MB RAM</td>
</tr>
<tr>
<td></td>
<td>• AGP graphic card, Direct Draw, 16 MB video memory (32/64 MB recommended for high resolutions/color depths)</td>
</tr>
<tr>
<td></td>
<td>• Windows XP, 2000, NT4.0*, ME* or 98*</td>
</tr>
<tr>
<td></td>
<td>• Internet Explorer 5.x or later</td>
</tr>
<tr>
<td></td>
<td>• For other operating systems and browsers see <a href="http://www.axis.com/techsup">www.axis.com/techsup</a></td>
</tr>
<tr>
<td></td>
<td>* Motion JPEG only</td>
</tr>
<tr>
<td><strong>System integration support</strong></td>
<td>• Powerful API for software integration available at <a href="http://www.axis.com">www.axis.com</a>, including</td>
</tr>
<tr>
<td></td>
<td>HTTP API, AXIS Media Control SDK, event trigger data in video stream,</td>
</tr>
<tr>
<td></td>
<td>embedded scripting, customized HTML pages</td>
</tr>
<tr>
<td></td>
<td>• Embedded operating system: Linux 2.4</td>
</tr>
<tr>
<td><strong>Supported protocols</strong></td>
<td>IP, HTTP, TCP, ICM P, RTSP, RTP, UDP, IGM P, RTCP, SMTP, FTP, DHCP, UPnP,</td>
</tr>
<tr>
<td></td>
<td>ARP, DNS, DynDNS, SOCKS, NTP</td>
</tr>
<tr>
<td></td>
<td>More information on protocol usage available at <a href="http://www.axis.com">www.axis.com</a></td>
</tr>
<tr>
<td></td>
<td>• FCC Part 15, Subpart B Class B, VCCI Class B</td>
</tr>
<tr>
<td></td>
<td>• C-tick AS/NZS 3548</td>
</tr>
<tr>
<td><strong>Approvals - Safety</strong></td>
<td>• UL and cUL (power supply), EN 60950, GS, FiMKO (AC Adapter)</td>
</tr>
<tr>
<td><strong>Dimensions (HxWxD) and weight</strong></td>
<td>• 130 x 104 x 130 mm (5.12” x 4.09” x 5.12”)</td>
</tr>
<tr>
<td></td>
<td>• 700 g (1.55 lb) excl. power supply</td>
</tr>
<tr>
<td><strong>MPEG-4 licensing</strong></td>
<td>MPEG-4 licenses (1 encoder, 1 decoder) included</td>
</tr>
<tr>
<td><strong>Accessories (not included)</strong></td>
<td>• AXIS 213CM Connection Module – provides duplex audio, I/O and analog</td>
</tr>
<tr>
<td></td>
<td>video output</td>
</tr>
<tr>
<td></td>
<td>• IP65-rated Dome Housing for installation of the camera in outdoor or</td>
</tr>
<tr>
<td></td>
<td>adverse, indoor environments</td>
</tr>
<tr>
<td></td>
<td>• AXIS 292 Network Video Decoder</td>
</tr>
<tr>
<td></td>
<td>• AXIS MPEG-4 Decoder 10 user license pack</td>
</tr>
<tr>
<td>Item</td>
<td>Specification</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Applications (not included) | • AXIS Camera Station - Surveillance application for viewing, recording and archiving up to 25 cameras  
• AXIS Camera Recorder - Surveillance application for viewing and recording up to 16 cameras  
• AXIS Camera Explorer - Basic software for viewing and manual recording  
See www.axis.com/partner/adp_partners.htm for more software applications via partners |

The AXIS 213 delivers the following **file sizes (PAL):**

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Min-Max (KB)</th>
<th>Resolution</th>
<th>Min-Max (KB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4CIF</td>
<td>704x576</td>
<td>10 - 300</td>
<td>4CIF</td>
</tr>
<tr>
<td>2CIF expanded</td>
<td>704x576</td>
<td>10 - 250</td>
<td>2CIF expanded</td>
</tr>
<tr>
<td>2CIF</td>
<td>704x288</td>
<td>5 - 150</td>
<td>2CIF</td>
</tr>
<tr>
<td>CIF</td>
<td>352x288</td>
<td>2.5 - 80</td>
<td>CIF</td>
</tr>
<tr>
<td>QCIF</td>
<td>176x144</td>
<td>1 - 20</td>
<td>QCIF</td>
</tr>
</tbody>
</table>

The AXIS 213 delivers the following **file sizes (NTSC):**

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Min-Max (KB)</th>
<th>Resolution</th>
<th>Min-Max (KB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4CIF</td>
<td>704x480</td>
<td>8 - 250</td>
<td>4CIF</td>
</tr>
<tr>
<td>2CIF expanded</td>
<td>704x480</td>
<td>8 - 200</td>
<td>2CIF expanded</td>
</tr>
<tr>
<td>2CIF</td>
<td>704x240</td>
<td>4 - 125</td>
<td>2CIF</td>
</tr>
<tr>
<td>CIF</td>
<td>352x240</td>
<td>2 - 70</td>
<td>CIF</td>
</tr>
<tr>
<td>QCIF</td>
<td>176x120</td>
<td>0.8 - 15</td>
<td>QCIF</td>
</tr>
</tbody>
</table>
General performance considerations

When setting up the camera, it is important to consider how various settings and situations will affect performance. Some factors affect the amount of bandwidth (the bit rate) required, others can affect the frame rate, and some will affect both. If the load on the CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

- High image resolutions and/or lower compression levels result in larger images. Bandwidth affected.
- Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Bandwidth affected.
- Simultaneous viewing of different streams (resolution, compression, etc.) by many clients. Frame rate and bandwidth affected.
- Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame rate and bandwidth affected.
- Heavy usage of event settings affects the CPU load. Frame rate affected.
- Enabled motion detection. Frame rate and bandwidth affected.
- Heavy network utilization due to poor infrastructure. Bandwidth affected.
- Viewing on poorly performing client PC lowers perceived performance. Frame rate affected.
- Access by large number of audio clients using full-duplex mode. Bandwidth affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 213 provides a tool that can be used to display these values directly in the video image.

To do this, special format strings are added as part of a text overlay. Simply add \#r (average frame rate in fps) and/or \#b (average bandwidth in Kbps) to the overlay.

For detailed instructions, please see the online help for Video & Image > Overlay Settings, and the help for File Naming & Date/Time Formats.
Important!

- The figures displayed here are the values as delivered by the camera. If other restrictions are currently in force, (e.g. bandwidth limitation) these values might not correspond to those actually received by the client.
- For Motion JPEG, these values will only be accurate as long as no frame rate limit has been specified.

Frame rates - Motion JPEG

The following test results show the frame rates in frames/second (fps) for Motion JPEG streams from the AXIS 213, using a compression level of 50%. Note that these values are guidelines only - actual values may vary.

<table>
<thead>
<tr>
<th>Frame Rate</th>
<th>fps</th>
</tr>
</thead>
<tbody>
<tr>
<td>4CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>2CIF expanded</td>
<td>25/30</td>
</tr>
<tr>
<td>2CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>QCIF</td>
<td>25/30</td>
</tr>
</tbody>
</table>

Frame rates - MPEG-4

The following test results show the frame rates in frames/second (fps) for MPEG-4 streams from the AXIS 213. Note that these values are guidelines only - actual values may vary.

The MPEG-4 test conditions:

- Compression level = 50%
- Video Object Type = Advanced Simple
- GOV structure = IP*

<table>
<thead>
<tr>
<th>Frame Rate</th>
<th>fps</th>
</tr>
</thead>
<tbody>
<tr>
<td>4CIF</td>
<td>17/21</td>
</tr>
<tr>
<td>2CIF expanded</td>
<td>17/21</td>
</tr>
<tr>
<td>2CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>QCIF</td>
<td>25/30</td>
</tr>
</tbody>
</table>

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate.
Bandwidth

As there are many factors affecting bandwidth, it is very difficult to predict the required amounts. The settings that affect bandwidth are:

- the image resolution
- the image compression
- the frame rate
- the MPEG-4 object type
- the MPEG-4 GOV structure
- the audio settings

There are also factors in the monitored scene that will affect the bandwidth. These are:

- the amount of motion
- the image's complexity
- the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be much lower.
Glossary of Terms

Active Speaker - a speaker with a built-in power amplifier.

ActiveX - A control (or set of rules) used by a browser. ActiveX controls are often downloaded and installed automatically as required.

ADPCM - Adaptive Differential Pulse Code Modulation. Predicts the analog signal digitally and the difference is coded.

AMC - AXIS Media Control. The control required for viewing video images in Internet Explorer. Installs automatically on first use.

API - Application Programming Interface. The Axis API can be used for integrating Axis products into other applications.

ARP - Address Resolution Protocol. A protocol for assigning an IP address to a physical device address that is recognized in the local network. The ARP command can be used to set the IP-address for your product.

ARTPEC - Axis Real Time Picture Encoder - used for video image compression.

CCD - Charge Coupled Device. CCD is one of the two main types of image sensors used in digital cameras. When a picture is taken, the CCD is struck by light coming through the camera’s lens. Each of the thousands or millions of tiny pixels that make up the CCD convert this light into electrons.

CGI - Common Gateway Interface. A set of rules (or a program) that allows a Web Server to communicate with other programs.

Client/Server - Describes the network relationship between two computer programs in which one, the client, makes a service request from another - the server.

dB (Decibels) - A unit to measure sound level changes. A 3dB change is the smallest level change we can hear. A 3dB change is actually twice or half the audio power level. A gain of 0dB will leave the signal level unchanged.

DC-Iris - This special type of iris is electrically controlled by the Axis camera, to automatically regulate the amount of light allowed to enter.

De-interlacing - An image quality improvement process taking a stream of interlaced frames and converting it to a stream of progressive frames.

DNS - The Domain Name System (DNS) locates and translates Internet domain names into IP (Internet Protocol) addresses.

Ethernet - A widely used networking standard.

ETRAX - Axis’ own microprocessor.

Firewall - A virtual barrier between a LAN (Local Area Network) and other networks, e.g. the Internet.

FTP - File Transfer Protocol. Used for the simple transfer of files to and from an FTP-server.

Full duplex - Transmission of data, e.g. audio, in two directions simultaneously.

G.711 - G.711 is the international standard for encoding telephone audio on 64 kBit/s channel. It is a pulse code modulation (PCM) scheme operating at 8 kHz sample rate.

G.726 - Frequently used speech-compression algorithm in telecommunications due to its high perceived speech quality and low resource requirements.

HAD - Hole Accumulation Diode. A HAD CCD design allows for more light to reach the imager, which reduces video noise to improve signal-to-noise ratio by up to 6dB (2x better than a standard CCD imager). Particularly effective when shooting in dark situations.

Half duplex - A half duplex link can communicate in only one direction, at a time. Two way communication is possible, but not simultaneously. Walkie-talkies and CB radios mimic this behavior in that you cannot hear the other person if you are talking.

HTML - Hypertext Mark-up Language. Used widely for authoring documents viewed in web browsers.


Intranet - A private network limited to an organization or corporation. Usually closed to external traffic.

IP - Internet-Protocol. See TCP/IP.

IP address - A unique number used by a network device, to allow it to be identified and found on the network. The 32-bit IP address is made up of four groups (or quads) of decimal digits separated by periods. An example of an IP address is: 192.168.0.1
ISMA - Internet Streaming Media Alliance

JPEG - A standard image format, used widely for photographs. Also known as JPG.

LAN - A local area network (LAN) is a group of computers and associated devices that typically share common resources within a limited geographical area.

Linux - A popular operating system, which is “open source” and practically free of charge.

Lux - A standard unit for the measurement of light, where 1 Lux equals the light emitted from a single candle at a distance of one meter.

Mbit/s - Megabits per second. A unit for measuring speeds in networks. A LAN might run at 10 or 100 Mbit/s.

MPEG-4 - A standard video format, used for low bandwidth video streams.

Multicast - The same information is sent only once and only to the intended recipients.

NTSC - National Television Standards Committee. NTSC is the standard format used for televisions in most of North and Central America, and Japan.

NWAY - A network protocol that automatically negotiates the highest possible common transmission speed between two devices.

PAL - Phase Altering Line. PAL is the standard format used for televisions in most of the world (other than the US, Canada, and Japan).

PCM - Pulse Code Modulation. Analog signal converted directly to a digital.

Ping - A small utility used for sending data packets to network resources to check that they are working and that the network is intact.

Pre/post alarm image - The images from immediately before and after an alarm.

Protocol - A special set of rules governing how two entities will communicate. Protocols are found at many levels of communication, and there are hardware protocols and software protocols.

Router - A device that determines the next network point to which a packet should be forwarded on its way to its final destination. A router is often included as part of a network switch (see below).

RTP - Real-Time Transfer Protocol. A transfer protocol designed for delivery of live contents, e.g. MPEG-4.

Simplex - In simplex operation, a network cable or communications channel can only send information in one direction.

SMTP - A common e-mail protocol.

Subnet Mask - An IP address consists of two components: the network address and the host address. “Subnetting” enables a network administrator to further divide the host part of the address into two or more subnets. The subnet mask identifies the subnet to which an IP address belongs.

Switch - Whilst a simple hub transmits all data to all devices connected to it, a switch only transmits the data to the device it is specifically intended for.

TCP/IP - Transmission Control Protocol/Internet Protocol. A suite of network protocols that determine how data is transmitted. TCP/IP is used on many networks, including the internet. TCP keeps track of the individual packets of information and IP contains the rules for how the packets are actually sent and received.

UPnP - Universal Plug and Play. An “address” on the network. UPnP is an architecture for pervasive peer-to-peer network connectivity of intelligent appliances, wireless devices, and PCs of all form factors.

URL - Uniform Resource Locator. An “address” on the network.

Varifocal - A varifocal lens provides a wide range of focal lengths, as opposed to a lens with a fixed focal length, which only provides one.

WAN - Wide-Area-Network. Similar to a LAN, but on a larger geographical scale.

Web server - A program on a computer (server) providing the resources (e.g. web pages) requested by the user (client).
Index

4CIF de-interlacing 19

A
Accessing the video stream 16
Action 34
Action Buttons 30
Active/Inactive 31
Administrator 39
Administrators 18
Advanced Simple profile 13
Alarm 34, 37, 48
AMC 11, 15
Audio 24, 48
Audio input 25
Audio mode 24
Audio output 25
AXIS Media Control 25

B
Backup 45
Bandwidth 13, 60
Bit rate 13
Brightness 19
Buffer Size 36
Buffers 36

C
CGI links 30
Color Setting 19
Compression 19
Connection Module 7, 48
Constant bit rate 13
Control Panel 12

D
Date & Time 40
Default 45
Default Video Format 31
Default Viewer 31
De-interlacing 19
DNS Configuration 41
DNS Server 41
Domain Name 41
Event 34
Event Servers 34
Event Types 35
Factory Default 47
File Sizes (NTSC) 57
File Sizes (PAL) 57
Frame Rate 20
Frame rates 59
FTP Server 34
Full duplex 24
Half duplex 25
Host Name 42
HTML Examples 31
HTTP API 30
HTTP Server 34
Include windows 37
IP Address Filtering 39
IR Light 6
IR light 12
LED Settings 45
Live View 18
Live View Config 28
Logs & Reports 46
M
Motion Detection 37
Motion JPEG 13
MPEG-4 5, 13, 19, 22, 44
MPEG-4 protocols 14
Multicasting 14

N
Network 40
Network Connector 6
Network Indicator 6
New Server Time 40
NTP Configuration 42
NTP Server 40

O
Operator 39
Other MPEG-4 clients 16
Output Buttons 31
Overlay Image 20
Overlay Settings 19
Own Home Page 30
Own web files 29

P
Pan/Tilt/Zoom Control Queue 12
Pan/Tilt/Zoom Controls 11
Password 9
Pinout 44
Pinout - I/O connectors 48
Port Status 38
Ports & Devices 44
Post-trigger Buffer 36
Power Connector 6
Pre-trigger Buffer 36
PTZ Commands 30
Pulse 10, 31
Push to talk 25

R
Referrals 40
Reset Button 6, 47
Resolution 19
Restart 45
Restore 45
Rotate Image 19
RTP 14
RTP (multicast) 44
RTSP 14

S
Scheduled Event 34, 37
Security 39
Security/Users 39
Sequence Mode 10
Serial Number 6
Services 41
Setup 18
Simple profile 13
SMTP 43
Snapshot 10
SOCKS 43
Streaming MPEG-4 14
Support 46
System Options 39

T
TCP Server 34
Time Mode 40
Triggered Event 34, 35
Troubleshooting 50

U
UDP 14
Unicasting 14
Upgrade Server 45
UPnP 44
User 39
User Defined Links 30
User List 39

V
Variable bit rate 13
Video Inputs 6
Video Stream 20
View Size 10